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Hypertension is a condition where the systolic blood pressure is > 140 mmHg and 
the diastolic pressure is > 90 mmHg. Hypertension is caused by the formation of 
angiotensin II from angiotensin I by Angiotensin Converting Enzyme (ACE). 
Lisinopril is one of the drugs commonly used to treat hypertension; however, 
long-term use may be associated with carcinogenic effects. This study aims to 
find candidates for new medicinal ingredients from luteolin derivative 
compounds contained in corn silk (Zea mays L.) as antihypertensives that have the 
activity of inhibiting ACE enzymes. Molecular docking and molecular dynamics 
simulations were employed in this study. The results showed that the TL59 
compound exhibited lower predicted toxicity than lisinopril. Based on molecular 
dynamics analysis, TL59 demonstrated an RMSD value of 1 Å and a ΔGTOTAL of 
– 44.65 kcal/mol, whereas lisinopril showed an RMSD value of 1.3 Å and a ΔGTOTAL 
of –29.25 kcal/mol. These findings suggest TL59 has a higher binding affinity and 
greater stability toward the 1O86 receptor than lisinopril. Therefore, TL59 is 
predicted to be a promising candidate for a new antihypertensive drug that 
inhibits the conversion of angiotensin I to angiotensin II. In conclusion, TL59 
demonstrates strong binding affinity and pharmacokinetic properties, indicating 
its potential as a promising antihypertensive candidate. However, this study is 
limited to in silico analysis and requires further in vitro and in vivo validation to 
confirm its efficacy and safety. 

 

1. Introduction 

Hypertension is a vascular disorder characterized by 
an increase in blood pressure above the normal threshold, 
defined as a systolic pressure greater than 140 mmHg and 
a diastolic pressure greater than 90 mmHg, confirmed by 
two separate measurements at different times [1]. 
According to data from the World Health Organization 
(WHO) [2], hypertension is a critical health issue that 
requires immediate attention. It is estimated to affect 
22% of the global population, with the highest prevalence 
observed in the African region (27%), followed by the 
Eastern Mediterranean (26%) and Southeast Asia (25%). 

According to the Indonesian Ministry of Health [3], 
the prevalence of hypertension in Indonesia is 34.1%, 
with rates of 21.20% among the pre-elderly (ages 45–59 
years) and 32.5% among the elderly (aged 60 years and 

above). West Java Province ranks fourth among regions 
with the highest prevalence of hypertension, at 29.4%. 
Within West Java, the districts and cities with the highest 
reported prevalence rates are Bogor City (101.9%), 
Cirebon City (99.7%), Sumedang Regency (98.7%), and 
Tasikmalaya Regency/City (13.5%) [4]. 

Hypertension can generally be managed through 
diet, exercise, and synthetic drug therapy, one of which is 
lisinopril, a drug known for its antihypertensive effect 
through inhibition of the angiotensin-converting 
enzyme (ACE). ACE is responsible for converting 
angiotensin I into angiotensin II, a potent vasoconstrictor 
that also stimulates aldosterone secretion [5]. However, 
long-term use of lisinopril has been widely reported to 
cause side effects such as coughing, nausea, vomiting, 
dizziness, headaches, and hepatotoxicity [6]. 
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The contribution of ACE to hypertension is part of the 
renin-angiotensin-aldosterone system (RAAS), a critical 
regulatory pathway for blood pressure and fluid balance. 
In this system, renin secreted by the kidneys converts 
angiotensinogen into angiotensin I, which is then 
activated to angiotensin II by ACE. Angiotensin II 
increases vascular resistance through vasoconstriction 
and promotes sodium and water retention by stimulating 
aldosterone release, leading to elevated blood pressure. 

Therefore, inhibiting ACE reduces the formation of 
angiotensin II, promotes vasodilation, decreases blood 
volume, and ultimately lowers blood pressure, making 
ACE a key therapeutic target in the management of 
hypertension. However, considering the side effects 
associated with current ACE inhibitors such as lisinopril, 
there is a need to explore alternative agents with similar 
inhibitory potential but improved safety profiles. Corn 
silk (Zea mays L.) is a promising natural source that 
contains bioactive compounds reported to exhibit ACE 
inhibitory activity [7]. By targeting ACE, these 
compounds could interfere with the RAAS, a critical 
regulator of blood pressure and fluid balance. 

Moreover, inhibiting ACE disrupts the conversion of 
angiotensin I into angiotensin II, a potent 
vasoconstrictor, promoting aldosterone secretion, 
leading to sodium and water retention. As a result, ACE 
inhibition not only reduces vascular resistance but also 
decreases blood volume, thereby offering an effective 
strategy for lowering blood pressure. This mechanism 
forms the basis for the therapeutic application of ACE 
inhibitors in hypertension management. 

Empirically, corn has been traditionally used by 
people in Eastern Indonesia as an antihypertensive and 
antidiabetic agent [8]. Corn silk contains several 
secondary metabolites, including alkaloids, flavonoids, 
and saponins, contributing to its potential as an 
antihypertensive agent [9]. Among these, flavonoid 
compounds such as luteolin, quercetin, rutin, 
kaempferol, rhoifolin, and apigenin have been reported to 
exhibit ACE inhibitory activity [10]. Previous in vivo 
studies have demonstrated that the infusion of a 
combination of corn silk and kernels (1:1) effectively 
reduced systolic and diastolic blood pressure in male rats 
[11]. 

Additionally, a 260 mg/kg BW dose of corn silk water 
extract has been shown to lower blood pressure in 20 
individuals with hypertension, partly attributed to its 
potassium-induced diuretic action [12]. Furthermore, an 
ethanol extract of corn silk and kernels at a dose of 500 
mg/kg BW was found to reduce systolic blood pressure by 
20.04 mmHg and diastolic pressure by 13.16 mmHg in rats 
with MSG-induced hypertension [7]. Luteolin, in 
particular, has been shown to inhibit ACE activity in MSG-
induced hypertensive mice [13]. 

Given these findings, further research is needed to 
identify active compounds derived from luteolin in corn 
silk (Zea mays L.) that may possess potent 
antihypertensive activity. One promising approach is 
through in silico studies, which involve computational 
techniques and data analysis to facilitate the exploration 

of drug candidates [14]. Therefore, this study aims to 
identify luteolin derivative compounds that meet toxicity 
and pharmacokinetic criteria and to investigate their 
interactions with the ACE receptor in silico, with the goal 
of discovering new candidate compounds with strong 
antihypertensive potential. 

2. Experimental 

2.1. Tools and Materials 

The tools used in this study included both hardware 
and software. The hardware consisted of a personal 
computer with the following specifications: processor - 
AMD A6-9220 RADEON R4, 5 COMPUTE CORES (2C+3G) 
2.50 GHz; installed RAM - 4.00 GB; system type - 64-bit 
operating system, x64-based processor; and device ID - 
C213A3F6-5BBD-4EEE-B5A9-B950A2F5EB9A. The 
software used included ChemDraw Ultra 8.0, 
AutoDockTools, MarvinSketch, Discovery Studio 
Visualizer, Molegro Molecular Viewer, PyRx, and various 
databases such as the Protein Data Bank (PDB), PubChem, 
and PDBsum. Additionally, toxicity and pharmacokinetics 
analysis were conducted based on Lipinski’s Rule of Five. 

The materials employed in this study were 100 
molecules of the corn silk luteolin derivative compound 
as the ligand, lisinopril as the reference compound, and 
the ACE receptor, obtained from the PDB with the code 
1O86 [15]. 

2.2. Ligand Preparation 

Ligands downloaded from PubChem were prepared 
by protonation and conformational adjustment using the 
MarvinSketch application. The protonation step was 
performed by selecting Tools > Protonation > Major 
Microspecies > OK. The pH was then adjusted to 7.4, 
which is the physiological pH of the body, and the file was 
saved in .mrv format. Subsequently, the conformation 
step was executed by selecting Tools > Conformation > 
Conformers > Save, and the file was saved in .mol2 
format. 

2.3. Receptor Preparation 

The ACE receptor was first downloaded from the 
RCSB PDB website (http://www.rcsb.org/pdb/) using 
receptor code 1O86. In AutodockTools, the receptor file 
was opened by selecting File > Read Molecule, followed by 
removing the water compound through Edit > Delete 
Water. Next, hydrogen atoms were added using Edit > Add 
Hydrogen > Polar Only > OK, and the file was saved in .pdb 
format. The receptor was then processed using Molegro 
Molecular Viewer by opening the file via File > Import 
Molecules, selecting only the protein section, and saving 
the receptor with Export Molecules > Export > Save .pdb 
[16]. 

2.4. Toxicity and Pharmacokinetics 

Toxicity and pharmacokinetic tests for luteolin and 
its derivatives were conducted using the PreADMET web 
server. For ADME testing, the PreADMET site was 
accessed, the ligand was uploaded, and the submission 
was completed. For toxicity testing, the Toxicity section 
of the PreADMET site was accessed, the ligand was 

http://www.rcsb.org/pdb/
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uploaded, and the submission was completed [17]. The 
parameters analyzed in the toxicity test included the 
Ames Test, Carcinogenicity in Mice, and Carcinogenicity 
in Rats. The pharmacokinetic parameters evaluated 
included Caco-2 permeability, Human Intestinal 
Absorption (HIA), and Plasma Protein Binding (PBB). 

2.5. Screening Ligand-Based Drugs Likeness (Drug 
Scan) 

Drug scan testing was conducted on the test 
compound, luteolin, and its derivatives to evaluate their 
physicochemical properties using Lipinski’s Rule of Five 
web server (http://www.scfbio-
iitd.res.in/software/drugdesign/lipinski.jsp) by following 
the steps: select file → click ligand → open → submit [16]. 
The parameters analyzed included molecular weight, log 
P value, number of hydrogen bond donors, number of 
hydrogen bond acceptors, and molar refractivity [18]. 

2.6. Docking Validation 

Validation was performed by first separating the 
receptor and then re-docking it with the natural ligand 
using AutoDock Tools. If the Root Mean Square Deviation 
(RMSD) obtained from the re-docking process was less 
than 2 Å, the method was considered valid [16]. 

2.7. Molecular Docking 

Molecular docking was performed using PyRx 
version 0.8, which integrates AutoDock Vina for docking 
simulations. The 3D structures of the ligands (luteolin 
derivatives and lisinopril as the reference) were first 
prepared by optimizing their geometry, adjusting 
protonation states to physiological pH (7.4), and 
converting them into PDBQT format. The target protein, 
ACE (PDB ID: 1O86), was retrieved from the Protein Data 
Bank and preprocessed by removing water molecules and 
co-crystallized ligands, adding polar hydrogens, and 
assigning Kollman charges using AutoDock Tools. 
A docking grid box was centered on the enzyme’s active 
site, with dimensions set at 40 × 40 × 40 Å to fully cover 
the binding pocket. Docking simulations were conducted 
to identify the most stable ligand conformations based on 
binding affinity (ΔG). The best binding pose for each 
ligand was selected according to the lowest binding 
energy and further analyzed for interactions using 
Discovery Studio Visualizer [19]. 

2.8. Molecular Dynamics 

Molecular dynamics (MD) simulations were carried 
out using AMBER 20 to evaluate the stability of ligand-
receptor complexes under physiological conditions. The 
selected complexes—TL49, TL59, and lisinopril bound to 
the ACE receptor (PDB ID: 1O86)—were parameterized 
using the General Amber Force Field (GAFF) for the 
ligands and the ff14SB force field for the protein. Each 
system was solvated in an orthorhombic box of TIP3P 
water molecules with a minimum buffer distance of 10 Å 
and neutralized by the addition of Na⁺ or Cl⁻ counterions. 
Energy minimization was performed in two stages: first 
with restraints on the protein-ligand complex, followed 
by an unrestrained minimization. This was followed by 

gradual heating from 0 K to 310 K over 100 ps under the 
NVT ensemble, then equilibration for 500 ps under the 
NPT ensemble. Production MD runs were conducted for 
20 ns at 310 K with a 2 fs time step, applying periodic 
boundary conditions and the particle mesh Ewald method 
for long-range electrostatics. Trajectories were analyzed 
using CPPTRAJ to compute the RMSD, Root Mean Square 
Fluctuation (RMSF), and Molecular Mechanics-
Generalized Born Surface Area (MM-GBSA) for binding 
free energy estimation [20]. 

3. Results and Discussion 

3.1. Target Receptor Identification 

The receptor used in this study was the crystal 
structure of the human ACE in complex with lisinopril 
(PDB ID: 1O86), with a resolution of 2 Å [15]. Receptor 
quality was assessed using Ramachandran plot statistics, 
focusing on key parameters such as the most favored 
regions [A.B.L], which accounted for 93.7%, and 
disallowed regions [XX], which were 0.0%. These results 
indicate that the protein structure is of good quality. The 
1O86 structure includes water molecules, which could 
complicate the molecular docking simulation. Therefore, 
receptor preparation involved separating the receptor 
from its natural ligand, water molecules, and extraneous 
residues. Removing water molecules was necessary to 
prevent hydrogen bond formation between water and the 
ligand, thereby allowing maximal observation of 
receptor-ligand interactions. The Ramachandran plot 
statistics are presented in Figure 1. 

 

Figure 1. Figure and plot statistics of the Ramachandran 
1O86 receptor 

 

Figure 2. Interaction of the 1O86 receptor binding site 

http://www.scfbio-iitd.res.in/software/drugdesign/lipinski.jsp
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Table 1. The example protonation and conformation of luteolin and its derivatives 

Compound Protonation Conformation 
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Figure 1 shows that the 1O86 receptor has an active 
site characterized by hydrogen bonds formed with amino 
acid residues ALA354, TYR523, HIS387, GLU384, HIS353, 
HIS513, TYR520, and LYS511. Hydrophobic interactions 
were observed with VAL518, PHE457, PHE512, GLY2000, 
GLN281, HIS383, VAL380, GLU162, and GLU411. These 
interactions at the active site are illustrated in Figure 2. 

Compared with the crystal structure of the lisinopril-
ACE complex reported by Natesh et al. [15], the docking 
study revealed both consistencies and variations in the 
key amino acid residues involved in ligand binding. In the 
original 1O86 structure, lisinopril primarily forms 
hydrogen bonds with residues such as ALA354, GLU384, 
HIS353, and TYR523, along with hydrophobic 
interactions with VAL518 and PHE512. In the redocking 
simulation, lisinopril maintained interactions with 
several of these critical residues, particularly GLU384 and 
LYS118, thereby validating the reliability of the docking 
protocol. Minor variations in hydrogen bond partners 
were observed, likely due to differences in ligand 
conformation and flexibility during the docking process. 

Furthermore, the docking simulation did not capture 
the zinc ion coordination stabilizing lisinopril binding in 
the crystallographic structure, as PyRx/AutoDock does 
not explicitly model metal coordination. Nevertheless, 
the preservation of major active site interactions suggests 
a strong level of comparability between the in silico 
approach and the established crystallographic data. 

3.2. Docking Validation 

Receptor validation was performed by docking or re-
docking molecules. The molecular docking results are 
considered valid if the RMSD value is less than 2.0 Å. A 
smaller RMSD value indicates better conformation [21]. 
The receptor validation results for the natural ligand 
bound to the receptor (PDB ID: 1O86), compared to the 
crystal structure of the human ACE, show that the natural 
ligand resides within a grid box of 40 × 40 × 40 Å 
dimensions, with the grid center coordinates at x = 
40.898, y = 32.394, and z = 47.905. The 34th docking run 
produced an RMSD value of 1.99 Å, with a Gibbs free 
energy (ΔG) of -8.18 kcal/mol. The ligand position within 
the grid box is shown in Figure 3. 

Figure 3 shows an overlay of the ligand conformation 
after docking with the original ligand (pre-docking), 
illustrating that the docked ligand is positioned closely to 
the original ligand. The overlay comparison between the 
co-crystallized and redocked lisinopril reveals an RMSD 
of 1.99 Å, indicating a close but not identical binding pose. 
The slight differences in orientation can be attributed to 
the absence of explicit modeling of the catalytic zinc ion 
in the docking simulation, which plays a crucial role in 
stabilizing the ligand in the crystal structure. 
Additionally, docking algorithms such as AutoDock 
approximate flexibility and electrostatics, which may 
lead to minor deviations from the experimentally 
observed poses. Despite these differences, the 
preservation of key binding site interactions validates the 
docking protocol. 

 

Figure 3. (a) Position of the ligands in the grid box and 
(b) shape of the natural ligand overlay from the initial 
1O86 receptor (green) and after simulated redocking 

(yellow) 

3.3. Ligand Preparation 

Ligand preparation involves the processes of 
drawing, protonation, and conformation for the luteolin 
compound and its derivatives, as well as lisinopril. 
Protonation is performed to adjust the ligands to the 
physiological pH of 7.4, while conformation ensures the 
ligand is in an appropriate shape to interact with the 
active site on the receptor [22]. The results of the ligand 
preparation are presented in Table 1. 

3.4. Toxicity and Pharmacokinetics 

Toxicity prediction was performed using the 
PreADMET web server. Toxicity refers to the ability of a 
chemical to cause harm to organisms, acting as a poison 
[23]. The toxicity testing aims to assess whether the test 
compound causes any harmful effects. The toxicity tests 
include the Ames Test, Carcinogenicity in Mice, and 
Carcinogenicity in Rats. The Ames Test is used to evaluate 
the mutagenic potential of a compound. The results of the 
toxicity screening are presented in Table 2. From Table 2, 
of the 100 test compounds, only nine compounds passed 
the toxicity test criteria, meaning they did not cause 
carcinogenic effects in rats or mice and were not 
mutagenic. Mutagenic testing is the primary screening 
method used to identify compounds that may cause DNA 
mutations, while carcinogenic testing helps determine 
compounds that could contribute to cancer development. 

Pharmacokinetic prediction is performed to assess 
the presence and activity of active substances in the body, 
helping to determine their pharmacological effects. The 
parameters analyzed include CaCo-2 permeability, which 
predicts the oral permeability of drugs. A good 
permeability is indicated by a value in the range of 4-70 
nm/second. HIA is used to estimate drug absorption in the 
human small intestine, with values between 70% and 
100% indicating good absorption. The PBB parameter is 
assessed to evaluate drug distribution in the body. A PBB 
value of <90% suggests weak binding to plasma proteins 
[24]. The pharmacokinetic prediction results are 
presented in Table 3. 

CaCo-2 permeability (nm/sec) is categorized as 
follows: <4 indicates low permeability, 4-70 represents 
medium permeability, and >70 indicates high 
permeability. %HIA is classified as 0-20% for poor 
absorption, 20-70% for moderate absorption, and 70-
100% for good absorption. %PPB is used to evaluate drug 
distribution: values >90% suggest strong binding to 
plasma proteins, while values <90% indicate weak 
binding. 
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Table 2. Results of toxicity screening of luteolin and its derivatives 

Compound 
Toxicity 

Ames Test Carcino Mice Carcino Rats 

Lisinopril 
(Reference) 

Non-mutagen (-) (+) 

Luteolin Mutagen (-) (+) 

TL1 Mutagen (+) (+) 

TL2 Mutagen (+) (-) 

TL3 Mutagen (+) (-) 

TL4 Mutagen (+) (+) 

TL5 Mutagen (+) (+) 

TL6 Mutagen (+) (-) 

TL7 Mutagen (+) (+) 

TL8 Mutagen (+) (-) 

TL9 Mutagen (+) (-) 

TL10 Mutagen (+) (+) 

TL11 Mutagen (-) (-) 

TL12 Mutagen (+) (-) 

TL13 Mutagen (+) (-) 

TL14 Mutagen (+) (+) 

TL15 Non-mutagen (-) (-) 

TL16 Mutagen (+) (-) 

TL17 Mutagen (-) (+) 

TL18 Mutagen (+) (+) 

TL19 Mutagen (+) (-) 

TL20 Mutagen (+) (+) 

TL21 Mutagen (+) (-) 

TL22 Mutagen (+) (-) 

TL23 Mutagen (-)  

TL24 Mutagen (+) (-) 

TL25 Mutagen (+) (-) 

TL26 Non-mutagen (-) (-) 

TL27 Mutagen (+) (+) 

TL28 Mutagen (+) (+) 

TL29 Mutagen (-) (-) 

TL30 Non-mutagen (+) (-) 

TL31 Mutagen (+) (-) 

TL32 Mutagen (+) (-) 

TL33 Non-mutagen (-) (-) 

TL34 Mutagen (+) (+) 

TL35 Mutagen (-) (+) 

TL36 Non-mutagen (+) (-) 

TL37 Mutagen (+) (-) 

TL38 Non-mutagen (-) (-) 

TL39 Mutagen (+) (-) 

TL40 Non-mutagen (+) (-) 

TL41 Non-mutagen (-) (+) 

TL42 Mutagen (+) (-) 

TL43 Mutagen (+) (+) 

TL44 Mutagen (+) (-) 

TL45 Mutagen (+) (-) 
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Compound 
Toxicity 

Ames Test Carcino Mice Carcino Rats 

TL46 Non-mutagen (+) (-) 

TL47 Mutagen (+) (+) 

TL48 Non-mutagen (+) (-) 

TL49 Non-mutagen (-) (-) 

TL50 Non-mutagen (+) (-) 

TL51 Mutagen (+)  

TL52 Mutagen (+) (-) 

TL53 Mutagen (+) (+) 

TL54 Mutagen (-) (-) 

TL55 Non-mutagen (-) (-) 

TL56 Non-mutagen (-) (-) 

TL57 Non-mutagen (-) (+) 

TL58 Mutagen (+) (-) 

TL59 Non-mutagen (-) (-) 

TL60 Mutagen (-) (-) 

TL61 Mutagen (+) (-) 

TL62 Non-mutagen (+) (-) 

TL63 Non-mutagen (-) (-) 

TL64 Non-mutagen (+) (+) 

TL65 Mutagen (+) (-) 

TL66 Mutagen (-) (-) 

TL67 Mutagen (+) (+) 

TL68 Mutagen (+) (-) 

TL69 Mutagen (+) (-) 

TL70 Mutagen (+) (+) 

TL71 Non-mutagen (+) (-) 

TL72 Mutagen (+) (-) 

TL73 Mutagen (+) (-) 

TL74 Mutagen (+) (+) 

TL75 Non-mutagen (-) (-) 

TL76 Mutagen (-) (-) 

TL77 Mutagen (+) (-) 

TL78 Mutagen (+) (-) 

TL79 Non-mutagen (+) (-) 

TL80 Non-mutagen (+) (-) 

TL81 Mutagen (+) (+) 

TL82 Non-mutagen (+) (-) 

TL83 Non-mutagen (+) (-) 

TL84 Non-mutagen (+) (-) 

TL85 Non-mutagen (+) (-) 

TL86 Non-mutagen (+) (-) 

TL87 Mutagen (+) (-) 

TL88 Mutagen (+) (+) 

TL89 Non-mutagen (+) (-) 

TL90 Non-mutagen (+) (-) 

TL91 Non-mutagen (+) (-) 

TL92 Non-mutagen (+) (-) 

TL93 Mutagen (+) (+) 

TL94 Non-mutagen (+) (+) 
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Compound 
Toxicity 

Ames Test Carcino Mice Carcino Rats 

TL95 Mutagen (+) (+) 

TL96 Non-mutagen (+) (-) 

TL97 Mutagen (+) (-) 

TL98 Mutagen (+) (+) 

TL99 Non-mutagen (+) (-) 

TL100 Mutagen (+) (+) 

 = Meets toxicity parameters 

 = Does not meet toxicity parameters 

Table 3. Prediction results of the pharmacokinetic 
aspects of luteolin derivatives 

No Compound 

Pharmacokinetics 

CaCo-2 
(nm/sec) 

HIA 
(%) 

PPB 
(%) 

1 
Lisinopril 

(Reference) 17.61 72.17 99.71 

2 TL15 6.12 5.63 52.17 

3 TL26 7.23 1 44.60 

4 TL33 2.88 0 40.11 

5 TL38 7.14 5.61 47.71 

6 TL49 3 1.37 46.86 

7 TL55 2.18 0 37.91 

8 TL56 5.45 6.66 63.29 

9 TL59 23.68 95.86 87.76 

10 TL63 6.12 5.63 52.17 

 = Meet the requirements of pharmacokinetic parameters 

 = Does not meet the requirements for pharmacokinetic 
parameters 

From Table 3, it can be analyzed that the CaCo-2 
value correlates with the permeability of the compound, 
indicating its ability to penetrate biological membranes. 
Almost all of the luteolin derivatives tested exhibit 
moderate permeability, with values ranging from 4 to 70 
nm/second. The HIA value reflects the ability of drug 
compounds to be absorbed in the intestine. HIA 
prediction is important because, for oral drugs to enter 
the bloodstream, they must be effectively absorbed 
through the intestinal wall. The PPB value is related to 
how drug candidates bind to plasma proteins during 
distribution. This factor influences the drug 
concentration available for distribution to various 
tissues, as only the free (unbound) drug can cross 
membranes and exert its effects in the body. 

3.5. Screening Ligand-Based Drugs Likeness (Drug 
Scan) 

Drug screening was conducted to determine the 
physicochemical properties of the tested ligands using 
Lipinski’s Rule of Five web server. This rule evaluates five 
parameters: molecular weight (MW) not exceeding 500 

g/mol, logP (coefficient value) less than 5, fewer than five 
hydrogen bond donors, fewer than 10 hydrogen bond 
acceptors, and a molar refractivity between 40 and 130 
[18]. The results of the drug screening are presented in 
Table 4. 

Molecular weight is associated with the distribution 
process, where compounds with an MW <500 g/mol can 
more easily penetrate biological membranes. In contrast, 
compounds with a molecular weight >500 g/mol face 
difficulty in crossing cell membranes. The number of 
hydrogen bond donors and acceptors is linked to the 
biological activity of a drug molecule. A higher capacity 
for hydrogen bonding requires more energy for the 
absorption process to occur [25]. 

The Log P value (Logarithmic Partition Coefficient) 
indicates a compound’s ability to dissolve in biological 
fluids. A higher Log P value indicates greater 
hydrophobicity, which can result in higher toxicity, as 
hydrophobic compounds tend to accumulate in the lipid 
bilayer and distribute widely throughout the body, 
potentially leading to less selective binding to the target 
enzyme. However, if the Log P value is too negative, the 
compound may be unable to cross the lipid bilayer 
membrane [25]. Molar refractivity reflects the total 
polarization of a drug particle. Non-polar compounds 
form forces that allow them to bind to receptors, while 
polar properties help the compound be excreted from the 
body during the digestive process [16]. 

3.6. Molecular Docking 

Molecular docking is performed on the target protein 
receptor using PyRx software. The simulations are 
conducted to determine the interaction conformation of 
the test compound with the receptor’s active site and to 
identify which test compound exhibits the best binding 
affinity. Binding affinity measures the potential of a 
ligand to interact with the target protein [26]. A lower 
binding affinity indicates a stronger interaction between 
the receptor and the ligand, while a higher binding 
affinity suggests a weaker interaction [27]. 

The molecular docking simulations of luteolin and its 
derivatives from corn silk were carried out on the 1O86 
receptor using the same grid box values as in the 
redocking validation phase. The docking analysis focuses 
on selecting the conformation of the compound with the 
lowest ΔG and inhibition constant (Ki) values [19]. 
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Table 4. Prediction results of the drug scan luteolin derivative test compound 

No Compound 

Parameter Lipinski’s Rule of Five 

Molecular 
weight 

(< 500 g/mol) 

Hydrogen bond 
donor (<5) 

Hydrogen bond 
acceptor (<10) 

Log P 
(<5) 

Molar refractory 
(40-130) 

1 Lisinopril (Reference) 405 0 7 -1.69 105.37 

2 TL15 580 2 15 0 0 

3 TL26 695 2 19 -7.14 160.78 

4 TL33 609 0 16 -4.73 125.56 

5 TL38 580 2 15 0 0 

6 TL49 447 0 11 -4.15 91.75 

7 TL55 641 2 18 -7.68 127.5 

8 TL56 463 2 12 -2.41 103.61 

9 TL59 449 0 6 0.10 119.09 

10 TL63 580 1 15 59.42 477.48 

= Fulfills Lipinski’s rules 

= Does not comply with Lipinski’s rules 

Table 5. Molecular docking results of luteolin derivative 
test compounds 

No Compound 
Binding energy 

(kcal/mol) 
Ki 

(µM) 
Run 

1 
Lisinopril 

(Reference) -6.33 22.92 33 

2 TL15 -5.69 67.67 94 

3 TL26 -3.27 3.98 87 

4 TL33 -5.28 135.42 4 

5 TL38 -6.98 17.74 17 

6 TL49 -6.07 35.52 83 

7 TL55 -4.24 776.61 80 

8 TL56 -5.98 41.54 84 

9 TL59 -9.10 0.211 16 

10 TL63 -6.06 36.14 9 

Free binding energy, or Gibbs free energy (ΔG), 
reflects the ability of a drug to bind to a receptor. A lower 
ΔG value indicates stronger binding affinity between the 
receptor and the ligand, whereas a higher ΔG value 
suggests weaker binding. The more negative the ΔG 
value, the better the affinity. The Ki is directly related to 
ΔG; a lower Ki value corresponds to a stronger binding 
interaction between the ligand and receptor. The results 
of the molecular docking of the luteolin derivative test 
compounds are presented in Table 5. 

Based on the results from toxicity screening, 
pharmacokinetics, drug scanning, and molecular binding 
of the luteolin derivative test compounds to the 1O86 
receptor, two compounds were identified with low ΔG 
and Ki values: compound TL49, with a binding energy of 
-6.07 kcal/mol, and compound TL59, with a binding 
energy of -9.10 kcal/mol. This indicates that TL59 has a 
stronger affinity for the 1O86 receptor than TL49 and the 
reference drug, lisinopril. Consequently, TL59 is 
predicted to have stable and favorable interactions with 
the 1O86 receptor, suggesting it may be a better candidate 
for antihypertensive therapy than lisinopril. 

Table 6. Interaction results of molecular docking of 
luteolin derivative test compounds 

Compound 

Interaction with amino acids 

Hydrogen bonds 
Hydrophobic 

bonding 

Lisinopril 
(Reference) 

LYS118, GLU403, 
GLU123 

TYR360, ARG522, 
MET223, HIS410, 

GLY404  

Natural ligand 

ALA354, TYR523, 
HIS387, GLU384, 
HIS353, TYR520, 

LYS511 

VAL518, PHE457, 
PHE512, GLY200, 
GLN281, HIS383 

TL49 
ASP358, TYR360, 

ASN70 
PHE391, ALA356, 
TYR62, TRP357, 
SER355, VAL351 

TL59 

ASP453, LYS454, 
GLU384, ALA354, 
CYS370, THR372, 

ASP 377 

VAL3789, HIS353, 
THR, 166, ALA170, 

GLU162, 

In addition to ΔG and the Ki, molecular docking also 
provides insights into ligand-receptor interactions at the 
active site, which are critical for determining the stability 
of the complex. The analysis primarily focuses on 
hydrogen bonds, as these are common in human 
biological systems, although hydrophobic interactions 
are also essential in maintaining the stability of ligand-
receptor binding [28]. The interaction results from the 
molecular docking of TL59 and lisinopril with the 1O86 
receptor are presented in Table 6. 

The results of the molecular docking, visualized in 
two-dimensional form (Figure 4), highlight the hydrogen 
and hydrophobic bonds formed between the molecules. 
Hydrogen bonds significantly influence the stability of 
ligand-receptor interactions, with an increase in binding 
energy indicative of stronger interactions between the 
ligand and the receptor [29]. 



 Jurnal Kimia Sains dan Aplikasi 28 (3) (2025): 155-167 164 

 

Figure 4. 2D visualization of the best binding poses based on free energy values: (a) lisinopril (reference), 
(b) compound TL49, and (c) compound TL59 

 

Figure 5. The RMSD graph 

In the 1O86 receptor (natural ligand), key hydrogen 
bond interactions at the active site involve the amino acid 
residues ALA354 and GLU384. Similar interactions are 
observed with the TL59 compound and the receptor. The 
overlap in binding residues between TL59 and the 
receptor suggests that TL59 effectively interacts at the 
active site, potentially exhibiting activity comparable to 
the co-crystallized ligand. These binding site residues are 
critical for stabilizing the ligand and modulating receptor 
function. 

3.7. Molecular Dynamics 

Based on the results of toxicity screening, 
pharmacokinetics, drug scans, and molecular docking of 
100 luteolin derivative test compounds, two compounds, 
TL49 and TL59, were selected due to their favorable ΔG 
values of -6.07 kcal/mol and -9.10 kcal/mol, respectively. 
These compounds will undergo molecular dynamics 
simulations to assess the stability of their interactions 
with the receptor. Molecular dynamics simulations, 
performed using AMBER software, include three 
compounds: lisinopril and the two selected test 
compounds, TL49 and TL59. These compounds were 
chosen based on their favorable binding energy values 
from initial screening. The simulations will evaluate the 
dynamic properties of ligand-receptor interactions, 
including temperature, pressure, and interactions over 
specified time intervals [20]. The results of the molecular 
dynamics simulation were analyzed to observe the 
changes in the ligand-receptor complex over time and to 
assess the stability of the complex structure. This analysis 
was carried out using key parameters, including RMSD, 
RMSF, and MM-GBSA. 

3.7.1. Root Mean Square Deviation (RMSD) 

RMSD is a parameter used to measure distance 
changes and ligand conformations in three-dimensional 
geometry. The RMSD value is calculated by comparing the 
initial ligand conformation with the conformation during 
simulation, presented in graphical form and plotted over 
time [20]. The RMSD values from the simulation results, 
expressed in angstroms (Å), are shown in Figure 5. 

Based on Figure 5, during the 20 ns simulation, TL49, 
TL59, and lisinopril all showed an increase in RMSD at the 
start of the simulation. TL59 maintained stability from 5 
ns to 18 ns, with an RMSD around 1 Å, followed by a slight 
increase between 19 ns and 20 ns. For lisinopril, the 
ligand-receptor complex exhibited unstable interactions 
until approximately 15 ns, after which stability was 
achieved from 16 ns to 20 ns with an RMSD value around 
1.3 Å. Meanwhile, TL49 displayed an interaction pattern 
similar to lisinopril but did not reach a stable state within 
the 20 ns timeframe, indicating that a longer simulation 
time may be needed. The TL59 compound demonstrated 
better stability than TL49 and lisinopril, as indicated by 
its consistently lower RMSD values. This suggests that the 
1O86 receptor exhibits better flexibility and more stable 
interactions with the TL59 compound. 

3.7.2. Root Mean Square Fluctuation (RMSF) 

RMSF is a measure of the deviation of a particle’s 
position relative to a reference position. The fluctuation 
value is calculated by assessing the extent to which the 
protein residues move during the simulation process [20]. 
RMSF can also be used to predict regions of protein 
flexibility by illustrating conformational changes in the 
protein chain throughout the simulation time [30]. Low 
fluctuation values in the residues indicate low 
adaptability and a stable connection in ligand-receptor 
binding, whereas high fluctuation values suggest high 
adaptability and a less stable interaction due to frequent 
positional changes during the simulation. The RMSF 
values from the simulation results, expressed in 
angstroms (Å), are shown in Figure 6. 

Based on Figure 6, it can be seen that the fluctuations 
of TL49, TL59, and lisinopril show almost the same 
fluctuation movements. The amino acid residue that 
experienced high fluctuations was the TL49 compound on 
the ASP105 amino acid residue, and the lowest fluctuation 
was the TL59 compound on the ASP37 amino acid residue. 
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Figure 6. The RMSF Graph 

The RMSF graph shows an increase in fluctuations in 
the 1O86 amino acid residue with the TL49 compound, 
the TL59 compound, and the lisinopril compound. In the 
TL59 compound, the highest fluctuation was the PRO154 
amino acid residue, but this amino acid did not play an 
important role as an active site. Better fluctuations can be 
shown by lower fluctuations, namely the ASP377 amino 
acid residue, which shows that the interaction of the TL59 
compound with the 1O86 receptor has better binding. The 
analysis was carried out using Discovery Studio software 
on the selected test compounds and lisinopril to see the 
position of the ligand and protein. It can be seen in Figure 
7 that the movement of ligands and proteins resulting 
from the visualization of the lisinopril compound with the 
TL59 compound produces good or stable interactions. 

The superimposition results illustrate the changes in 
the ligand’s position relative to the protein during the 
molecular dynamics simulation. A closer alignment 
between the ligand and the protein indicates a stronger 
and more stable interaction. 

3.7.3. Molecular Mechanics-Generalized Born Surface 
Area (MM-GBSA) 

The free energy (ΔG) obtained through the MM-
GBSA calculation method reflects the binding affinity of a 
compound to its receptor. A lower ΔG value indicates a 
stronger ability of the compound to bind to the receptor 
[31]. Among the three compounds tested through 
molecular dynamics simulations—compound TL49, 
compound TL59, and lisinopril—the MM-GBSA results 
are seen in Table 7. 

Table 7. Results of free binding energy calculations for 
ligand–receptor systems of selected luteolin derivative 

test compounds 

Energy 
(kcal/mol) 

TL49 TL59 Lisinopril 

VDWAALS -32.69 -55.45 -41.47 

EEL 305.41 153.9 218.68 

EGB -5.30 -5.44 -5.03 

ΔGgas (VdW+EEL) 272.72 98.45 177.20 

ΔGsolv (EGB + ESURF) -280.53 -143.11 -206.45 

ΔGTOTAL (VdW + EEL + 
EGB + ESURF) -7.81 -44.65 -29.25 

 

Figure 7. Superimposition of the molecular dynamics 
simulation results: (a) lisinopril–1O86 complex and 

(b) TL59–1O86 complex 

Based on Table 7, it can be observed that the ΔGTOTAL 
value obtained from the MM-GBSA calculations for the 
TL59 compound system is lower at -44.65 kcal/mol 
compared to TL49 (-7.81 kcal/mol) and the reference 
compound, lisinopril (-29.25 kcal/mol). This indicates 
that TL59 has a better binding affinity and greater 
stability than both TL49 and the reference compound. 
Therefore, TL59 is predicted to be a promising 
antihypertensive drug candidate targeting the ACE 
receptor (PDB ID: 1O86). TL59 is proposed to exert its 
antihypertensive effect by inhibiting the conversion of 
angiotensin I to angiotensin II, thereby reducing 
peripheral vascular resistance and lowering blood 
pressure [32]. 

4. Conclusion 

Based on the research conducted, it can be concluded 
that out of the 100 luteolin-derived test compounds from 
corn silk (Zea mays L.), only nine compounds met the 
requirements for toxicity, pharmacokinetics, and 
Lipinski’s Rule of Five through in silico screening. The 
interaction between the luteolin derivatives and the ACE 
receptor involved hydrogen bonds and hydrophobic 
interactions. Notably, key hydrogen bond interactions 
were observed with the amino acid residues ALA354 and 
GLU384, suggesting that the TL59 test compound may 
exhibit similar biological activity by binding to the same 
critical residues. TL59 demonstrated the best potential as 
an antihypertensive drug candidate in silico, with a lower 
molecular docking free energy (ΔG) of -9.10 kcal/mol 
compared to the reference compound (-6.33 kcal/mol). 
Furthermore, the MM-GBSA free energy calculation 
revealed that TL59 exhibited a lower total free energy 
(ΔGTOTAL) of -44.65 kcal/mol compared to the control 
compound (-29.25 kcal/mol). These findings highlight 
TL59 as a promising lead compound for antihypertensive 
drug development targeting ACE. However, since this 
study was limited to computational predictions, future 
research should involve in vitro enzyme inhibition 
assays, cell-based functional studies, and in vivo 
validation to confirm the efficacy, bioavailability, and 
safety profile of TL59 in biological systems. 
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